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Overview

Networks have long been used to represent important biological processes. Many of us remember
memorizing the Krebs (TCA) cycle, which is usually shown as a directed graph, itself a type of network
(Figure 1). Recently, however, the use of networks in biology has changed from purely illustrative and
didactic to more analytic, even including hypothesis
formulation. This shift has resulted, in part, from the
confluence of advances in computation, informatics,
and high-throughput techniques in systems biology.
Today the analysis and visualization of biologically
relevant networks has become commonplace, whether
the networks represent metabolic, regulatory, or
signaling pathways; protein-protein or genetic
interactions; or more abstract connections between
similar proteins or similar ligands. Networks are now
routinely used to show relationships between
biologically relevant molecules, and analysis of those
networks is proving valuable for helping us understand
those relationships and formulate hypotheses about
biological function.

Figure 1. The TCA cycle from WikiPathways

With the advent of high-throughput methods that generate vast amounts of data from diverse
measurement sources — for example gene expression data from microarrays, protein or metabolite
abundance from mass spectrometry — biological networks have become increasingly important as an
integrating context for data. As a commonly understood diagrammatic representation for concepts and
relationships, networks provide structure that helps reduce underlying complexity of the data. Network
tools give us functionality for studying complex processes. We can analyze global characteristics of
the data, via metrics such as degree, clustering coefficient, shortest paths, centrality, density. We can
identify key elements (hubs) and ‘interesting’ subnets, which can help us to elucidate mechanisms of
interaction. Also, visualization of data superimposed upon the network can help us understand how a
process is modulated or attenuated by a stimulus.

Network tools hgve proven to be extr(_amely useful in CEQRAQBEws  ® B
analyzing and visualizing important biological processes. je.e oo oy raa onry SRS
Some general applications of networks in biology include: . ;

* Gene Function Prediction — Examining genes ‘ S ) (Do
(proteins) in a network context shows connections A
to sets of genes/proteins involved in same
biological process that are likely to function in that
process [1-4].

Figure 2. Gene Function Prediction using
jActiveModules



+ Detection of protein complexes/other modular structures — although interaction networks
are based on pair-wise interactions, there is clear evidence for modularity & higher order
organization (motifs, feedback loops) [5-9]
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Figure 3. ldentifying molecular complexes in large protein interaction
networks using MCODE

* Prediction of new interactions and functional associations — There are several methods for
predicting interactions and functional associations, based upon network structure and
correlations amongst data. For example, orthology-based methods have been used to predict
interactions for a species based upon orthology to interacting pairs of proteins in evolutionarily
similar organisms[10]. Other researchers have used Bayesian network approaches to inferring
gene regulatory networks from time course gene expression data[11]. In another approach,
shown on the example below, statistically significant domain-domain correlations in protein
interaction network suggest that certain domain (and domain pairs) mediate protein binding.
Machine learning extends this to predict protein-protein or genetic interaction through integration
of diverse types of evidence for interaction [12-14].
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Figure 4. Visualizing domain interactions and alternative splicing
using DomainGraph



Moreover, these same tools and their associated analysis and visualization methods can provide key
insights in the study of disease and in drug development. These include:

+ Identification of disease subnetworks — identification of disease network subnetworks that
are transcriptionally active in disease. These suggest key pathway components in disease
progression and provide leads for further study and potential therapeutic targets [15-20].

Figure 5. Gene expression profiles and American Heart Association (AHA) histological
classification of atherosclerotic lesions (left panel). Differentiation scores were calculated for
all genes across pairwise conditions (e.g. diabetic vs. non-diabetic patients). A large literature
network was built for atherosclerosis. Connectivity analysis was used to extract a
transcriptionally-active subnetwork for diabetic vs. non-diabetic conditions (right panel).

+ Subnetwork-based diagnosis — subnetworks also provide a rich source of biomarkers for
disease classification, based on mRNA profiling integrated with protein networks to identify
subnetwork biomarkers (interconnected genes whose aggregate expression levels are
predictive of disease state[21, 22]).
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Figure 6. A network-based approach identified prognostic markers not as individual genes but
as subnetworks extracted from molecular interaction databases. Gene expression profiles
from Chronic Lymphocytoic Leukemia patients were mapped to a large human molecular
interaction network. A search over this network was performed to identify prognostic
subnetworks that could be used to predict treatment-free survival.



+ Subnetwork-based gene association — molecular networks will provide a powerful framework
for mapping common pathway mechanisms affected by collection of genotypes[23, 24].
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Figure 7. Cytoscape Mondrian plugin with a dataset
derived from the TCGA Glioblastoma Pilot Project. This
dataset contains mutations, copy-number alterations,
and expression data for 91 samples.

For the purposes of this tutorial, we will classify
biological networks into three major categories:
pathways, similarity networks, and interaction
networks.
and signaling networks. Figure 2 shows a pathway
containing genes involved in glioblastoma
multiforme, a major form of brain cancer [25].
These genes were identified by a large-scale
genetic analysis of copy number variation and
genetic changes in 206 glioblastoma multiforme
patients. The study was conducted as part of The
Cancer Genome Atlas (TCGA) project. Notably,
the study demonstrated that there was no single
genetic defect responsible for glioblastoma
multiforme, but that all of the cases showed
significant pathway changes — strongly suggesting
that this form of cancer is a “pathway disease.”
From a visualization standpoint, the real power is
the ability to map expression, mutation, or copy

Pathways include metabolic, regulatory,

Figure 8. Partial pathway showing genes implicated
in glioblastoma multiforme colored by the changes
in copy number



number variation data onto pathways to reveal (or suggest) how the pathway and its components
function under different sets of conditions, including disease states. Thus, the ability to analyze a
variety of data sources and types and to map that data onto pathways is crucial. There are also
techniques for deriving putative pathways from expression data’ and for modeling the kinetics of
biological processes [26] that are beyond the scope of this talk.

Interaction networks comprise the second
category. In these networks, nodes represent
biological entities and edges represent some
form of interaction or relationship. A common
example of this type is a protein-protein
interaction (PPI) network. Figure 3 shows a
yeast protein-protein interaction network
generated by tandem affinity purification
followed by mass spectrometry (TAP/MS) [27].
Analogous networks have been generated
based on ligand similarities [28], protein
similarities [29], and drug-target networks [30].
Generally, this class of biological networks can
present as a “hair ball”, where there is so much . . . o .
information that the meaningful relationships are Pigure 9. Partial protein-protein interaction network
L . . . for Saccharomyses cerevisiea colored by predicted
difficult to discern. There is good evidence that complexes.
analysis of a PPl network to find highly
connected “hubs” can be used to predict protein complexes [8], and clustering of protein similarity
networks can provide clues to protein family (and hence functional) assignments (Figure 4).

A variety of analytical techniques can help to elucidate interaction networks. Clustering methods such
as MCL [31] have proven valuable, although several algorithms more specific to various types of
interaction networks have also been developed (c.f.[5]. In addition to clustering, a variety of metrics
can be applied to an interaction network or nodes within the network. The average density (node
degree) of the network, average shortest-path distance, number of connected components, measures
of centrality, and the extent to which the network fits a scale-free model are all useful descriptors for the
analysis of an interaction network. Altering the layout and
visual attributes of the network can also be helpful.

Cytoscape is an open-source application for the
visualization and analysis of (biological) networks. During
my talk, | will use Cytoscape to demonstrate some of the
techniques for visualizing and analyzing biological
networks. In addition, | will demonstrate some ways that
biological networks can be combined with other data to
help elucidate function or the possible implications of
changes in biological function due to perturbation,
mutation, or infection.

Figure 10. Protein similarity network of the
i family colored

1 ¢.f. the ExpressionCorRa&tiéon plugin from Gary Bader's lab: http://baderlab.org/Software/ExpressionCorrelation
Z It's approximately 2 because the shortest path between a non-hub node and all of the other nodes is 2







Introductions and setup

Introductions

The three instructors we have today are all
experienced Cytoscape developers, with a
cumulative of 15 years of participation in the
Cytoscape core team. All three have a strong
background in Cytoscape development, both from
the perspective of core development, but also from
the perspective of developing plugins that extend
Cytoscape functionality. All three instructors have
a long history of working in the biomedical field,
both from the perspective of tool developers and
the underlying science.

Notes
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— Cytoscape core team since 2006
— Author of several Cytoscape plugins
* SFLDLoader, structureViz, clusterMaker, chemViz,
metanodePlugin, groupTool, commandTool, bioCycPlugin

3

Introductions

 Allan Kuchinsky
— 1999-Current

* Principal Project Scientist, Agilent Laboratories, Agilent
Technologies

— 1996-1999
« Principal Project Scientist, HP Laboratories, Hewlett Packard
— 1984-1996
« Project Manager, Hewlett Packard
— Cytoscape core team since 2005
— Author of several Cytoscape plugins
« Agilent literature search plugin, HyperEdge Editor, Nature
Protocols Workflow plugin, GoLayout, BubbleRouter

4

Introductions

¢ Alex Pico, Ph.D.
—2010-Current

« Executive Director, National Resource for Network
Biology

—2007-Current

+ Bioinformatics Group Leader, Gladstone Institutes, UCSF
— Cytoscape core team since 2007
— Developer of several Cytoscape plugins:
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Setup

For the purposes of this tutorial, we will be using -
Cytoscape 2.8 (the current release is 2.8.3). The Installation
Cytoscape team is working on a new release, 3.0,
which represents a significant architectural
advance over the current release, but it has not
been released as of this writing. Cytoscape has _ Sample data files
several components: the “core” of Cytoscape, _ PDFs for hands-on portions
which is distributed as a Java jar file, a set of

“core” plugins that are always distributed with

Cytoscape and provide some important

functionality, a set of sample files, and a very

large set of plugins the extend Cytoscape’s z
functionality (in some ways significantly).

» CD Contents
— Cytoscape 2.8.1 installers for Mac, Linux, Windows
— Several additional plugins

Cytoscape 2.8 is available as installers for Mac, B Installation

Windows, and Linux, which include the core,

core plugins, and sample files. Plugins are * If you have not yet installed Cytoscape 2.8:
generally available for download with — Install Cytoscape 2.8.1 by executing the appropriate

installer

Cytoscape’s Plugin Manager. * If desired, copy plugins into your Cytoscape

It is also possible to load plugin jar files directly plugins folder

from hard disk or CD. To avoid potential

— Linux: {Cytoscape install directory}/plugins

— Windows: \Program Files\Cytoscape v2.8.0\plugins

network problems or contention, we have — Mac OS X: /Applications/Cytoscape_v2.8.0/plugins
provided all of the plugins that we will use for * Alternatively, can use Install Plugin From File
today on the CD that we’ve distributed. to install the desired plugins

8
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Biological Networks

In this section, we will begin to explore the use of
networks in biology. We begin by posing a
challenge: how do we make sense of biological
networks? We pose that challenge by providing a

series of pictorial examples of networks in biology.

The Challenge

The images on this slide are all representations of
biological networks. The challenge we are faced
with is to extract the “meaning” behind these
representations, which may be a purely visual
challenge, but it might also involve analytical
approaches.

All of the images at the right represent biological
networks, including the Excel spreadsheet.
Without more information about the content,
these images don'’t tell us much. How can we
extract this meaning? What are the analytical
techniques? What are the common visualization
approaches?

Notes

R The Challenge &
» Making sense out of biological networks....
The Challenge S

» Making sense out of biological networks....

The Challenge

* Making sense out of biological networks....




If we simply think of a biological network as a list of
nodes and the edges that connect them, we’re not
going to be able to gain much information. However,
if we add information to those nodes and edges to
that we can analyze the interactions (or similarities)
in more depth, or we use that additional information
to visualize the nodes in some meaningful manner,
we will find it easier to gain (or communicate)
insight about aspects of the network. There are a
number of analytical and visualization approaches
that can help us, which are described below.

Taking the networks that we showed before, we can
begin to analyze or visualize additional data. In the image
at the right, we've colored the nodes in the network by
protein family membership (members of protein families
share functional characteristics), and then performed an
edge-weighted layout where the edge weights represent
the BLAST similarity between the proteins. As you can
see pretty quickly that similar proteins tend to group
together.

In this example, we’ve combined a network
representation with an analysis of some of the
associated data. The image at the left is a hierarchical
clustering of all of the genes in the TCGA glioblastoma
study vs. all of the patients in the study. This allows us
to look for patterns in the heat map and associate those
patterns with specific genes or groups of genes in the
pathway.

In the final example on the right, we have combined two
different visualizations with two different analyses. The
heat map on the left represents a hierarchical cluster of
genetic interactions and the network shows the results of
an MCL cluster of a set of physical interactions. These
views are linked, allowing users to select groups in one
view and determine if the same groups exist in the other
view. This allows researchers to explore areas where
there are tight protein-protein physical interactions as
well as genetic interactions, providing pretty strong
evidence for the existence of a complex.

The Challenge &

* Biological networks (nodes and edges)
— Seldom tell us anything by themselves

— Analysis involves:
» Understanding the characteristics of the network
— Modularity
Comparison with other networks (specifically random networks)
— Visualization involves:
« Placing nodes in a meaningful way (layouts)
* Mapping biologically relevant data to the network
Node size
— Node color

Edge weights

But, how do we know what kinds of analyses make sense, and what kinds of visualizations are

appropriate?



Biological Network Taxonomy

Before tackling this question, we need to understand that not all “biological networks” are the
same. In particular, there is a sort of taxonomy of networks - each visualization or analytical
technique can be either more or less appropriate for the different network types. For our
purposes, we can divide these biological networks into 3 main groups: pathways, interaction

networks, and similarity networks.

Pathways

The first type of network in our taxonomy is
probably the most familiar. We've all seen
pathway diagrams, whether those pathways
represent signaling pathways, metabolic pathways,
or regulatory pathways. These networks are often
hand-curated diagrams that have been
constructed for didactic purposes. However, even
though the positions and graphical annotations
associated with these networks does not lend
them to the normal types of network analysis
techniques, they can be extremely useful as
templates on which we can paint expression
profile information, or any other kinds of

@ Biological Network Taxonomy &

* Pathways
— Signaling
— Metabolic

— Regulatory
— Phylogeny (could also be thought of as similarity)

annotation that we want to use to show information associated with the curated pathway.
Phylogenetic trees can also be thought of in a similar fashion of those trees have been hand
curated like the kinase phylogenetic tree [32] shown in the slide.

Notes




Interactions

The second type of networks in our taxonomy are RE1 Biological Network Taxonomy
interaction networks. While pathways are

probably familiar to most because of their use for « Interactions

educational purposes, interaction networks are ~ Protein-Protein interactions

what most people of when we think of “network = Protein-Ligand interactions

biology”. Basically, these networks reflect the = enetgnno

. . . . iy — Domain-Domain interactions
interactions between biological entities. The

— Others
entities might all be proteins, giving us the « Residue or atomic interactions
canonical protein-protein interaction network Gellicellniemetions
shown to the right in the first frame. The E:’;i;::loz'vo'ogv
interacting entities might also be genes, in which - Social networks

case, the network could be a genetic interaction
network. The middle panel at the right shows a
particular representation of an epistatic
miniarray profile (EMAP). These networks are
formed by recording the differential results of
double-delete mutants when compared to the
expected combination of single-delete mutants.
The last network shows a protein-ligand
interaction network. Interaction networks don'’t
necessarily need to have only one interacting entity, and as we are rediscovering the importance
of metabolic pathways, the “metabolome”, which combines metabolites with the enzymes and
regulatory proteins which control metabolism. There are also efforts underway to understand
how the interactomes of pathogens interact with the interactomes of their hosts - yet another
kind of “mixed” interaction network.

Of course, there are many kinds of biological interactions we might be interested in, up to and
including how people interact with each other. Such social networks are beyond our scope, but
social network analysis is very similar to biological networks analysis and provide a fruitful source
of algorithms and visualization techniques.

Notes




Similarity ®%  Biological Network Taxonomy &

The final type of networks we want to discuss are

ey ey * Similarity
similarity networks. In similarity networks, the

— Protein-Protein similarity

nodes represent biological entities and the edges — Chemical similarity
represent some measure of the similarity between ~ Ligand similarity (SEA)
them. There are several types of similarity — Others

networks that are commonly used in biology today. gi:“]’;fl;

One common similarity metric is the Tanimoto
coefficient[33-35], which represents the similarity
between two small molecules based on the
chemical fingerprints of each of them[36]. Other :
similarity metrics include sequence similarity as
measured by BLAST[29, 37], PSI-BLAST[38], or
Smith-Waterman[39], structural similarity as measured
by RMSD or other structural similarity measures[40-
45], or the ligand similarity as measure by the similarity
ensemble approach (SEA) method[28].

There are other types of non-biological networks that
use various kinds of similarity measures. Tag
clouds[46] and topic maps[47], which is one of the
semantic web technologies.

The images at the right show two examples of
similarity networks. The network on top is a protein-
protein similarity network showing the
Amidohydrolase enzyme superfamily from the
Structure-Function Linkage Database (SFLD)[48].
The colors on the network represent proteins of
similar function. Note that these proteins tend to
group together based on their BLAST similarity[29].

The network on the bottom shows a network of small-

molecules where the edges represent the Tanimoto

similarity between them. These networks can be useful to find molecules with similar structural
characteristics

Notes




Analytical Approaches

The analysis of networks is a large and complex topic that we can’t do justice in a single tutorial
(even less a tutorial handout). In general, network analysis is part of the mathematics known as
graph theory, and there are entire conferences (and many textbooks) devoted to the area. A good
starting point might the Wikipedia article[49] or the online book “Graph Theory with
Applications”[50]. Our goal here is to provide a brief introduction and touch on some of the main

approaches used with biological networks.

Concepts
In mathematical terms, a biological network (any
network for that matter) is a graph, often written:

G = (V(G), E(G), Yo)
where V(G) are the set of vertices (nodes) in the
graph and E(G) are the set of edges. In this
particular notation, ¢ is the set of incidence
functions that define which edge goes with which
vertices.

The edges between nodes can either be directed or
undirected. This is easiest to understand when
considering the degree of a node. In an undirected
network, the degree of a node is simply the

number of edges connected to it. In the first simple
network at the right, the node (node0) has three
edges connected to it, so it has a degree of 3. Ina
network with directed edges, we need to expand our
concept of degree to include in-degree, the number
of edges that connect to this node, and out-degree,
the number of edges that originate from this node.
In the second network at the right, the size of the
nodes reflects the node degree.

There are also differences between the types of
networks. The first network at the right is a
multigraph. In a multigraph, there can be multiple
edges between nodes. The network at the far right
on the other hand, is a hypergraph. In a hypergraph,
an edge can be connected to more than two edges.

Notes

Analytical approaches S

» Concepts
— Graph/Network correspondence
— Node/Vertex correspondence
— Edge directedness
+ Usually a network property
— Node degree
— Multigraph
+ Allow multiple edges between nodes
— Hypergraph
+ Allow edges to connect more than 2 nodes

1




Scale-free networks
One property of network topology that is of

Analytical approaches S

interest is the degree distribution - that is, the + Scale-free networks
distribution of how many edgeS each node has — Degree distribution follows power law: P(k) ~ k7,

(also referred to as the connectivity
distribution)[51]. A network is said to be scale-

where y is a constant.

— Result is that there are distinctive “hubs” (essential
proteins?)

free if the degree distribution fits a power law. It — Overall, though, network is resilient to perturbation
has been I‘epOI‘ted that many types of biologica] — Biological (and social) networks tend to be scale-

free

networks are scale free[52-62]. The
characteristics of scale-free networks are that
there is a short path from any node to another
node (small world property), there are many nodes
with few connections and a few nodes

with many connections (hubs), and the
hubs are enriched with essential /legal
nodes (centrality and lethality
principal)[52, 63].

Scale-free networks have interesting
properties for biological systems - in :

particular, they are robust to random —
breakdowns[64]. They are also (as the
name implies) invariant to changes in o
scale. On the other hand, recent analysis o s o o e
of several data sources have begun to —
throw into question exactly how well

many biological networks fit the scale-free

power law distribution[63, 65-67]. So, while none of the

authors have suggested that biological networks don’t

exhibit some scale-free characteristics, they don't fit the power-law degree distribution well

enough to be considered scale-free.

It should also be noted that biological networks aren’t the only network type that tends to be
scale-free. For example, both social networks and the Internet tend to be scale-free[68, 69]. In
both cases the overall topology tends to be one with a few hubs of high degree and lots of lower-

degree nodes.

Notes




Random networks Analytical approaches &
Random networks (random graphs) are important

tools for determining the extent to which a + Random networks
computationally derived network differs from a — Algorithms exist to create random networks
similar “random network”. This is, in principal, the “eEatrandom s trors s dos Ko

* High clustering coefficient: Watts-Strogatz

same idea behind the BLAST expectation value or + Scale-free: Barabasi-Albert
the p value that you might get from a statistical test. ~ Nodes have similar degrees

— Useful to compare your network vs. a random
Networks, however, are complicated, and network

developing an appropriate probability model is non-

trivial. There are several algorithms commonly

used to generate random networks. In the simplest

case, you can just generate a graph, G(n,p), where for

any two nodes N1 and N, there is a probability p

that there is an edge between them[70]. This is similar to the Erdés-Rényi model([71, 72] as cited
in [73]), but in the Erdds-Rényi model, the number of edges is restricted to a fixed number, M.
Thus, the graph, G(n,M), is a graph where all of the M edges appear with equal probability.

The problem with both of these “flat” models is that neither of the models are likely to result in
graphs that exhibit the characteristics of biological networks (small world, scale-free) discussed
above. One approach to this is to explicitly model the random graph such that it exhibits small-
world properties (short average path lengths and high clustering). The is the approach proposed
by Watts and Strogatz[74]. In the Watts and Strogatz model, there are three key parameters: the
number of nodes, N, the mean degree of the nodes, K, and a tuning parameter f, which is between
0 and 1. The algorithms begins by generating a network with N nodes, each connected to K
neighbors, K/2 on each side. Then for every edge (n;n;) rewire that edge with probability  such
that there are no loops and there is no duplicate edges. The result depends on the value of 5. If

is near zero, the result is a regular lattice. If § is one, this approaches the random graph similar to
NK

Another approach is to implement a random graph that is scale-free. The Barabasi-Albert model is
an approach to generating random scale-free graphs[68]. This approach starts with a small
network G(n,m), where n is the number of nodes (22) and m is the number of edges. The
requirement is that all nodes have degree of at least 1. Then new nodes are added according to a
probability pi:

the Erdés-Rényi model with p =

ki
pi= ko P 2jki
2iki [

where k; is the degree of the node i. This results in hubs (nodes with more edges) continuing to
get more edges and nodes with fewer edges being less likely to get new edges. This results in a
degree distribution that fits the scale-free model quite well, but is still random in nature.



Network measures
We’ve the three most common network measures Analytical approaches S
already: node degree, path length, and clustering
coefficient. The first two of these are intuitively

* Network measures
— Node degree

underStandable- The thlrd iS d httle more dlfﬁCUlt * Node indegree: # of edges for which this node is a target

to Conceptualize Since lt doesn’t flt our Concept Of * Node outdegree: # of edges for which this node is a source
. . . — Shortest path length

ClUSterS (l'e' grouplngs Of nOdeS or mOdUIarltY) « Shortest traversal distance between two nodes

very well. « Can be weighted if edges have weights or hops if not
— Clustering coefficient
* Measures how close the neighbors of a node are to being a
clique (fully connected group)

Node degree is, as we've already mentioned, the

number of edges connected to this node. In a + # of edges connecting a node’s neighbors/the node’s

degree

directed network, the node indegree is the number

of edges directed towards this node, and the node
outdegree is the number of edges directed away

from this node. In the network at the right, for
example, node3 has an indegree of 2 and an outdegree
of 1 (assuming we count the undirected edge as both
in and out).

Path length is also relatively easy to imagine. If we

look for the shortest path from node0 to node3 (the

first network at the right) it’s the edge between them.

On the other hand, the shortest path from node3 to
node0 goes through node2 (because the edge

between node0 and node3 is directed). The length of the
path is often just a hop count (1 in the first example, 2 in the
second), but can also be weighted, which might mean the
shortest path is not the path that traverses the fewest nodes.

The clustering coefficient is a measure of the degree to which
nodes form a complete graph. It was originally defined to
measure the degree to which a network exhibits small-world
properties[74]. For undirected graphs, the local clustering

~ ZHeij

coefficient is given as: Ci =
ki(ki—1)

In the network example at the right (assuming it’s undirected), node3 has two neighbors (degree
2), node2 and node0 share an edge, so we have (2*1)/2(2-1) = 1. On the other hand, node0 is
degree 3, but only node2 and node3 are connected, so we have (2*1)/3(3-1) =.3. The network
average clustering coefficient can be used to express the degree to which a graph exhibits small-

— 1 n
world properties. The average is simply: C = — _CIi
n<~i-



Another important set of networks measures that
ISee . an
has important properties are the various sk Analytical approaches <
centrality measures. These approaches (in
general) attempt to provide a measure of the  Centrality - measures of node importance
; . — Degree centrality (find hubs
importance of a given node. There are many egree centrality (find hubs)
K . . * Degree of this node / (# of nodes — 1)
centrality measures, but we'll just discuss three of . Betyeenness centrlity (cssentialin)
them here. + The average number of shortest paths that go through this
node

The first centrality measure we’ll discuss is degree = Closenes centrality _
* The sum of all shortest paths between this node and all

centrality. Nodes with high degree centrality are other nodes / (# of nodes — 1)
the hubs in scale-free networks, for example. This

is an easy measure to compute the degree
centrality (Cp) of node v: Cn(v) = %, where n is
the number of nodes in the network.

Betweenness centrality is another centrality measure than tends to reflect the essentiality of a node
in the network. Essentially it measures to extent to which “all roads lead through” this node. The

betweenness centrality for a node v is calculated as: Cs(v) = E *() where o is the number

s=v=tEV  Ost
of shortest paths from s to t and o5 (v) is the number of shortest paths from s to ¢ that go through v.
Intuitively, this makes sense - if a large percentage of the shortest paths between two nodes go
through a given node, removal of that node will have a significant effect on the network topology
(from the perspective of those two nodes).

Closeness centrality is the degree to which this node is close to all other nodes. It is again

ievey S(v)
n-1 4

and t. So, in a star topology, where all nodes are connected to a single hub, the closeness centrality
measure for the hub is 1 and ~2 for all other nodesz2.

calculated based on shortest paths: Cc(v) = where S(v,t) is the shortest path between v

Notes

Z It's approximately 2 because the shortest path between a non-hub node and all of the other nodes is 2
except for the hub node, in which case the shortest path is 1.



Clustering Analytical approaches &

Clustering is a heavily used technique for N Clustering (find hubs, complexes)

analyzing networks, both biological and otherwise. — Goal: group related items together
The overall goal of clustering is to group items * Clustering types:
together that are related based on some measure. — Hierarchical clustering
. . . + Divide network into pair-wise hierarchy

Clustering is an active area of research and there - KNS i
are many clustering algorithms that have long * Divide network into & groups
been used for biological applications, and even = MEL o

i i * Uses a flow simulation to find groups
more algorithms that are being developed for — Community Clustering
Specialized purposes. » Maximize intra-cluster edges vs. inter-cluster edges

7

Before we talk about specific clustering

approaches, it is important to understand that all

of the clustering approaches depend on some metric for determining the similarity of the items
being clustered. This similarity metric is termed a distance metric in clustering terms, and there
are a number of ways to calculate the distance in feature space (that is, the terms or values you are
using to determine the similarity between objects). A common measure is the Euclidean distance,
which is simply the distance between two points in n-dimensional space:

dpg) =@ -p) +(q2-p2) + .t (gu - po)’

Other common techniques are based on the Pearson correlation, r, between any two series of
numbers x = (x, Xz, ..., Xn) and y = (y1, Y2, ..., yn), which is defined as:

xi—x|yi-y
i1\ 0% Oy

1 n

r=—

)

where is the standard deviation of the x series, and is the standard deviation of the y series.

This term can be either centered (as above), or uncentered, which assumes a mean of zero (even if
it's not). There are many other approaches to calculating the distance, from taking the negative
log of the BLAST e-value to much more complicated approaches designed to account for specific
characteristics of the data.

Hierarchical Clustering

A very common clustering approach is hierarchical clustering[75]. As the name implies, this
approach divides the objects into a pairwise hierarchy. Hierarchical clustering has been used for
many years as one of the major approaches to analyzing and visualizing microarray data[76]. An
important first step in performing hierarchical clustering is to determine the distance metric
(above). The second step is to determine how to link the pairwise distances3:

* Single linkage clustering takes the minimum pairwise distance,
*  Complete linkage clustering takes the maximum pairwise distance,
*  Average linkage clustering (UPGMA) takes the average of all of the pairwise distances,

3 This list is taken from the clustering approaches used in the original Cluster program from Eisen
and colleagues, which has been inherited by clusterMaker and other Cluster-clones.



* Centroid linkage clustering takes the distance between the centroids of all pairs of elements.
Once the metrics and linkages have been selected, clustering may be accomplished by either an
agglomerative (bottom-up) or divisive (top-down) method. In either case, the result is tree
(hierarchy) where the nodes closer together in the tree are more similar. For microarray data,
this is often shown as a dendrogram associated with the heatmap that reflects the fold changes in
the expression data (see the example below).

k-Means Clustering

Another common clustering technique is k-means[77, 78]. In k-means clustering the algorithm
divides the data set up into k groups in such a way that the value of the item gets assigned to the
cluster with the nearest mean. The approach is relatively simple: given a set of n data items the
idea is to partition the n items into k sets so as to minimize the within-cluster sum of squares
(WCSS):

.k
oo Dl

i=1 xjESi

where S = (S1, Sz, ..., Sn) are the clusters and u; are the mean of the points in each cluster S;. k-
means has been used in a number of applications, and has been incorporated in to a number of
other algorithms.

There are many other clustering algorithms and combinations of algorithms used in network
applications - far too many for us to cover here. Often these algorithms are general algorithms
(e.g. Community clustering[79], MCL[31, 80, 81], Spectral Clustering[82-86], and Affinity
Propagation[87, 88]) and often they designed for special purposes (e.g. SCPS[89], MCODE[5],
FORCE[90], TransClust[91]). Some algorithms are actually combinations of algorithms (e.g.
AutoSOME[92]). We're going to cover only three of these algorithms (MCL, Spectral, and Affinity
Propagation), but the interested reader is encouraged to explore the references below.

MCL Clustering

MCL clustering (MCL is short for Markov Clustering) is a clustering approach that simulates a
weighted random walk through a network. The idea behind the algorithm is that because edges
within the natural groupings will most likely stay within the group, the vast majority of the steps



in a random walk will be within the natural group. The other way to think about it is by imagining
edges as flows - most of the flow through a network with natural clusters will stay within the
clusters - very little will flow between the clusters. The simulation of the random walk is by
alternate application of two operations: expansion and inflation. First, the distance matrix is
converted to a stochastic matrix (a non-negative matrix where each of the columns sums to 1). In
the expansion step, the stochastic matrix is squared using the normal matrix product. In the
inflation step, the Hadamard product of the matrix (entry-wise multiplication by an inflation
parameter, [) is taken. After the inflation step, a scaling step is added which returns the matrix to
a stochastic matrix. Repeated expansion and inflation will have the result of removing cells in the
distance matrix (i.e. edges) that represent inter-cluster edges.

MCL clustering has been used for a large number of biological applications, including the finding of
protein complexes in protein-protein interaction networks and the grouping of proteins in protein
similarity networks. MCL has proven to be very fast and robust with then number of edges is
reasonably low, but can have problems resolving dense networks necessitating some form of
algorithm or user-chosen cut-off value to reduce the edge density[93]. MCL has the nice
characteristic that it does not necessitate the user to select the number of clusters in advance,
although the inflation parameter I does have to be specified.

Spectral Clustering

Spectral clustering takes in name from the use of spectral properties of the similarity (or distance)
matrix constructed from the network. Given a set of data points A, the similarity matrix may be
defined as a matrix S where Sjj represents a measure of the similarity between points i and j which
are members of the set A. Spectral clustering techniques make use of the spectrum of this matrix
of the data to perform dimensionality reduction for clustering in fewer dimensions.

One such technique is the Normalized Cuts algorithm[94, 95], commonly used for image
segmentation. It partitions points into two sets (51,52) based on the eigenvector v corresponding to
the second-smallest eigenvalue of the Laplacian matrix

L=1-D:SD"

of S, where D is the diagonal matrix
Dij = ESU
i

This partitioning may be done in various ways, such as by taking the median m of the components in v,
and placing all points whose component in v is greater than m in S}, and the rest in S,. The algorithm can
be used for hierarchical clustering by repeatedly partitioning the subsets in this fashion.

A related algorithm is the Meila-Shi algorithm[82], which takes the eigenvectors corresponding to the &
largest eigenvalues of the matrix P =SD™' for some k, and then invokes another (e.g. k-means) to cluster
points by their respective k£ components in these eigenvectors.



Spectral clustering techniques are very useful in biology, but they have the disadvantage that since they
essentially divide the data into two sets, you must either combine them with something like k-means or
use a hierarchical decomposition to arrive at a more refined clustering.

Affinity Propagation

Affinity propagation[87] is a newer algorithm that takes a message passing approach rather than a
mathematical approach to clustering. Basically, as with the other approaches, affinity propagation
takes a similarity matrix s(ij), which represents the starting point of the algorithm. In addition,
each point is given a preference value s(k k) which is used to seed the likelihood of this point being
an exemplar for the formation of a cluster (this is often just set to a flat value to allow the
algorithm to learn the number of clusters). Then, the points exchange messages of two types:
responsibilities (r(i,k)) are sent from point i to point k and reflects the degree to which k is a good
exemplar for point i; and availability (a(i,k)) is sent from point k to point i to reflect the evidence
for i to choose k for its exemplar. The algorithm runs until some stopping point usually based on
the degree to which r(i, k) and a(i, k) change during each pass. See their web site (http://
www.psi.toronto.edu/index.php?q=affinity propagation) for more information about the
algorithm and its application.

Affinity propagation has numerous applications in biology and seems to perform well in the
datasets provided by the authors. Some comparative analysis by others[96] suggests that other
algorithms might be less susceptible to noise and more robust for some applications.

Notes




Analytical approaches &

Network motifs
A network motif is a pattern of connectivity that

) * Motif finding
occurs more frequently than might be expected

— Search directed networks for network motifs (feed-

by a random connection of nodes[97]. As might forward loops, feedback loops, etc.)

be expected by the reuse we often see in biology, » Overrepresentation analysis

bio]ogica] networks tend to have a small set of — Find terms (GO) that are statistically overrepresented
in a network

network motifs that act like components in a
larger circuit[98, 99]. Network motifs have
been identified in the gene regulation network of
E. coli[100] as well as a larger set of
networks[101]. There are a number of network :

motifs that have been identified in biology,

including feed forward loops[102-106] (like the o
one shown at the right), feedback loops[107-109], positive and negative
auto-regulation loops[110]. These biological circuits are critical to

— Not really a network analysis technique
— Very useful for visualization

regulatory processes in the cell, so identifying them in protein-protein e
interaction networks can provide important clues to the pathway which

the protein participate in[111-113]. O
Overrepresentation analysis Simple Feed

. : . : : : F dL
Overrepresentation analysis (ORA) is an important tool used to identify s e

aspects or attributes of a subset of nodes that are statistically more common in those nodes than
in the full set. The most common approach is to cluster ___ - ———
a group of genes based on expression data and look for Loserz st
overrepresentation of various gene ontology

(GO)[114] terms in the groups to determine if a
particular expression pattern suggests a particular
biological process[115-118].

One of the things to keep in mind when doing ORA is
that the resultant p-values may need to be adjusted
since multiple tests are conducted. This makes sense -
if we're performing multiple tests we increase the
possibility that we'll get a false positive based on
random chance. Two methods for correcting for
multiple tests are the Dunn-Bonferroni Familywise
Error Rate (FWER)[119] correction and the Benjamini
& Hochberg False Discovery Rate (FDR)[120]
correction.

eno BNGO output

The image at the right shows the results of an overrepresentation analysis of a yeast expression
data set using the Cytoscape BiNGO plugin[121].



Visualization

In the previous sections, we made use of a number of visualization techniques that are easily taken
for granted. In this section, we will detail the techniques and key decisions involved in producing
network and pathway visualizations. Using biological networks to visualize data is a critical aspect
of exploratory analysis: facilitating interpretation, new insights and new hypotheses (PMID:
20824171). We are visual creatures, after all.

Depiction — — |
The basic visual motif of networks in Cytoscape is that of nodes and

edges. In biological networks, the nodes often represent genes, @)@z%@
proteins or small molecules, while the edges (or lines) represent — )
interactions and relationships between connected nodes (see figure at MOM? —(s 3

the right). Beyond this core motif, all other visual features (e.g., shape,
size, color, thickness, label, transparency, etc) are flexible and can be
used to represent practically any data value, annotation or attribute.

Data Mapping

The first thing most users want to do in Cytoscape is to map their data
onto networks for visualization. The variety of data and network types
has already been explored in previous sections. Here, we

will focus on the mechanics of data mapping using the B! Data mapping &
VizMapper interface.

Node and edge motif in
various visual styles

Mapping of data values associated with graph
elements onto graph visuals

VizMapper provides a user interface for controlling the Visual attributes

mapping of data attributes to visual attributes. There is ~ Node fill color, border color, border width, size,
a long list of available visual attributes that can be shape, opacity, label A o
. . . . — Edge type, color, width, ending type, ending size,

mapped to, including node properties such as fill color, ending color
border color, shape, width, height, opacity and label, 3 Mﬁ;pplglg tyie(i ol

] B — Passthrough (labels
and edge properties such as type, color, thickness, as _ Continuous (numeric values)
well as arrow type, size and color. — Discrete (categories)

Notes




Data attributes can be mapped in three main ways: Passthrough - directly passing the data value
to the visual attribute, e.g., labels. Continuous - mapping a continuous range of numerical values
to a range of visual attributes, e.g., expression values to a color gradient. Discrete - mapping
discrete data values (string or numeric) to specified visual attributes, e.g., five different categories

to five different colors.

The next two examples focus on two types of Continuous
data mapping, since these are the most useful and most
challenging. First, we map degree-of-connectivity (the
data attribute) to node size (the visual attribute), so
that more connected nodes appear proportionally
larger, thus highlighting potential “hubs.” In the
VizMapper interface, you would begin by double-
clicking on ‘Node Size’ and selecting the data attribute
containing degree information. Then select “Continuous
Mapping” type and click the graphic to edit the mapping
parameters. The min and max of the data attribute is
given as the x-axis and the visual attribute is the y-axis.

The second example maps continuous expression
values to node color. Once again in the VizMapper
interface, you would double-click the visual attribute,
pull-down the data attribute and then choose
“Continuous Mapping.” When you click on the graphic,
you will notice a different parameterization. Once again,
the data attribute is given as the x-axis, but now instead
of a y-axis, you will find thresholds that control the ends
and mid-point of a color gradient as well as step-
function thresholds to set discrete colors for values
exceeding the gradient range. This is a handle tool for
focusing the continuous mapping of color to a critical
range of data.

Notes

Data mapping




Layouts

The majority of network information does not come
with fixed coordinates. With the exception of manually
curated pathway diagrams, networks typically rely on
automated layout algorithms to position nodes and
edges. Cytoscape comes with a wide variety of built-in
layout algorithms that can be applied to any pathway or
network. In addition, a number of plugin extensions
have been developed to support additional layouts.

Here, we will describe the main layout types natively
supported by Cytoscape. You can find these in the menu
Layout > Cytoscape Layouts.

Grid Layout - a simple layout of nodes in arbitrary
order arranged in a grid pattern. This layout does not
take in account edge crossings, weights or degree of
connectivity.

Group Attributes Layout - performs a grid layout but
orders nodes according to a user-selected attribute, e.g.,
ascending order based on a numerical attribute.

Hierarchical - based on connectivity, this layout
defines ordered layers of nodes in a tree structure, e.g.,
phylogenetic trees.

Layouts
 Layouts determine the location of nodes and
(sometimes) the paths of edges
e Types:
— Simple
* Grid
* Partitions
— Hierarchical
« layout data as a tree or hierarchy
* Works best when there are no loops
— Circular (Radial)
« arrange nodes around a circle
« could use node attributes to govern position
— e.g. degree sorted
i Layouts SH Layouts )

e Layouts SH Layouts &

Circular Layout - arranges nodes around the circumference of a circle. The order of the nodes is
arbitrary in the basic version. There two other versions: Attribute Circle Layout, which orders
nodes based on a user-selected attribute, and Degree Sorted Circle Layout, which orders nodes
based on their number of connections. Pro-tip: The Degree Sorted Circle Layout calculates the
degree for each node and creates a new attribute that can be used for other purposes as well, e.g.,

data mapping.

Notes




Force-Directed Layout - simulates edges as springs,
resulting in clusters of highly connected nodes with

minimally connected nodes spaced and in the periphery.

You can also choose to influence the layout based on an
edge attribute, if available. A related layout is Spring
Embedded, which also simulates edges as springs. Both
of these layouts also have explicit Edge-Weighted-
versions that provide more control.

Furthermore, you can apply layouts to selected subsets
of nodes. If you make a node selection prior to browsing
the Layout menu, you will see an additional submenu
option to apply the layout to “All nodes” or “Selected
Nodes Only.” By using this feature, you can effectively
combine different layouts for a single network. For
example, after applying a Force-Directed Layout, you
could then select a connected subset and apply a
Hierarchical Layout just to that set.

To achieve just the right visual layout for your network,
you may need to “tune” a layout algorithm. You can do
this by going to Layout > Settings... and then select the
layout algorithm you want to tune. The settings expose
the parameters of each algorithm so that you can
explore different layout behaviours.

Notes

Layouts

¢ Types:
— Force-Directed
« simulate edges as springs
* may be weighted or unweighted
— Combining layouts
« Use a general layout (force directed) for the entire graph,

but use hierarchical or radial to focus on a particular
portion

— Multi-layer layouts
« Partition graph, layout each partition then layout partitions
— Many, many others

e Layouts S Layouts

Layouts

Use layouts to convey the relationships between
the nodes

Layout algorithms may need to be “tuned” to fit
your network
— Layouts—> Settings... menu

Lots of parameters to change layout algorithm
behavior

Can also consider laying out portions of your
network




Animation LY Animation
There are cases where a static image doesn'’t tell the

whole story. Perhaps you have collected data in a time i f;;lvrvlﬁf’n is useful to show changes in a
series or have more than one condition you want to  Overa fime series

compare. Animation is a key technique for visualizing — Over different conditions

Change_ — Between species

There are a handful of plugins for Cytoscape that

support automatic, step-wise animation through

defined VizMapper styles (e.g., clusterMaker and

VistaClara). But there is also a dedicated plugin called

CyAnimator that supports flexible animation creation. By Animation

Using CyAnimator, you choose the frames of the
animation as you work. Interpolation fills-in the
transitions between frames for a wide range of visual
features, including position, size, color, and opacity. A
final set of images are generated and ready to be
imported into a number of free or commercial movie file
generators.

Notes




Introduction to Cytoscape

Cytoscape is an open source bioinformatics software
platform for visualizing molecular interaction

networks and biological pathways and integrating
these networks with annotations, gene expression
profiles and other state data. Although Cytoscape was
originally designed for biological research, now itis a
general platform for complex network analysis and
visualization. Cytoscape core distribution provides a
basic set of features for data integration and
visualization. Additional features are available as
plugins (now called Apps). Plugins are available for
network and molecular profiling analyses, new layouts,
additional file format support, scripting, and connection
with databases. Plugins may be developed by anyone
using the Cytoscape open API based on Java™ technology
and plugin community development is encouraged. Most
of the plugins are freely available.

Cytoscape is a collaborative project between the
Institute for Systems Biology (Leroy Hood lab), the
University of California San Diego (Trey Ideker lab),
Memorial Sloan-Kettering Cancer Center (Chris Sander
lab), the Institut Pasteur (Benno Schwikowski lab),
Agilent Technologies (Annette Adler team), the
University of Toronto (Gary Bader Lab), Gladstone
Institutes (Bruce Conklin and Alex Pico), and the
University of California, San Francisco (Tom Ferrin lab).

Notes

Introduction to Cytoscape

* Overview
* Core Concepts
— Networks vs. Attributes
— VizMapper
Plugins
* Working with Data
— Loading network from the Web
— Importing networks from csv files or Excel
— Importing attributes from csv files or Excel
The attribute browser

» Cytoscape tips & tricks

What is Cytoscape?




Core Concepts

Cytoscape creates networks, where nodes of the
network represent objects (such as proteins) and
connecting edges represent relationships between
them (such as physical interactions). Each Edge
connects two Nodes. Edges can be directed or
undirected. In the case of a directed edge, there is a
Source and a Target Node. Once this basic network is
created, various attributes of the nodes and edges
(such as protein expression levels or strength of
interaction) can be added to the network and
incorporated as visual cues like shape or color.

Notes

Core Concepts

Networks and Annotations

Networks
e.g, biological pathways

Networks

e o

VizMapper

Annotations
e.g., attributes or data

Annotations




Visual Styles

One of Cytoscape's strengths in network visualization is the ability to allow users to encode any
attribute of their data (name, type, degree, weight, expression data, etc.) as a visual property (such
as color, size, transparency, or font type). A set of these encoded or mapped attributes is called a
Visual Style and can be created or edited using the Cytoscape VizMapper. With the VizMapper,
the visual appearance of your network is easily customized. For example, you can:

Use specific line types to indicate
different types of interactions.

Set node sizes based on the degree of
connectivity of the nodes.

Browse extremely dense networks
by controlling for the opacity of
nodes.

Set node font sizes based on the degree of
connectivity of the nodes.

Visualize Gene Expression data its biological context by
superimposing colors onto the nodes based upon their Gene
Expression data values.




Plugins

Cytoscape allows users to extend its functionality
by creating or downloading additional software
modules known as “plugins” or “Apps”. These
plugins provide additional functionality in areas
such as network data query and download
services; network data integration and filtering;
attribute-directed network layout; GO enrichment
analysis7; as well as identification of network
motifs, functional modules, protein complexes, or
domain interactions.

Links to these plugins can be found at
http://apps.cytoscape.org

Altogether, Cytoscape and its plugins provide a
powerful tool kit designed to help researchers
answer specific biological questions using large
amounts of cellular network and molecular
profiling information.

Notes

Core Concepts

* Plugins!

http://cytoscape.org/plugins.html

Cytoscape

 Traditional uses
— Visualizing:
« PPI
« Pathways
— Mapping:
« Expression profiles
* “Other state data”

_u
&




BiNGO

BiNGO is a Java-based tool to determine which
Gene Ontology (GO) categories are statistically
overrepresented in a set of genes or a subgraph
of a biological network. BiNGO is implemented
as a plugin for Cytoscape.

BiNGO maps the predominant functional themes
of a given gene set on the GO hierarchy, and
outputs this mapping as a Cytoscape graph. Gene
sets can either be selected or computed from a
Cytoscape network (as subgraphs) or compiled
from sources other than Cytoscape (e.g. a list of
genes that are significantly upregulated in a
microarray experiment).

The main advantage of BINGO over other GO tools is the
fact that it can be used directly and interactively on

molecular interaction graphs. Another plus is that

BiNGO takes full advantage of Cytoscape's versatile
visualization environment. This allows you to produce

customized high-quality figures.

BiNGO features include:

* Assessing overrepresentation or
underrepresentation of GO categories
* Graph or gene list input

* Batch mode: analyze several clusters simultaneously

using same settings
* Different GO and GOSlim ontologies
* Wide range of organisms
* Evidence code filtering

Cytoscape: Platform

» Cytoscape as a platform
— Plugin architecture

« http://www.cytoscape.org/plugins.html

— BINGO
* GO Over expression analysis
— MCODE

« Finding protein complexes

— Agilent literature search plugin
« Creating networks from the literature
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Welcome to Cytoscape 2.3 Right-chck + drag to ZOOM

Middie-clck + drag to PAN

* Hypergeometric or binomial test for overrepresentation
* Multiple testing correction using Bonferroni (FWER) or Benjamini&Hochberg (FDR) correction
* Interactive visualization of results mapped on the GO hierarchy.

e Extensive results in tab-delimited text file format

* Ability to make and use custom annotations, ontologies and reference sets



Agilent Literature Search
Agilent Literature Search Software is a meta-search

tool for automatically queI‘yil’lg multlple text-based Amures.arch 2.3 beta 3 (LitSearch version 2.3) (=]} 4]
search engines (both public and proprietary) in order Temr= ot
to aid biologists faced with the daunting task of iy
manually searching and extracting associations among I’
. . Search Controls
genes/proteins of interest. P e TR —
Extraction Controls
Agilent Literature Search Software can be used in e —
conjunction with Cytoscape, which provides a means (e ) 0 e
) L(;\fém W.n beta OR ifnb1 OR nterferon-beta OR “ifn beta™ OR ifnb OR ifb OR moraEaS6 OR “nterferon beta® OR ifnbeta))
of generating an overview network view of 0 e
gene/protein associations. X & )
[ Refiesh | Query Matches [(Reandyze |

- . . Completed: A | Completed
Agilent Literature Search software provides an easy- 1@ ot o P R—— -
to-use interface to its powerful querying capabilities. S [T A
When a query is entered, it is submitted to multiple ‘
user-selected search engines, and the retrieved | )
results (documents) are fetched from their Ty };’E DK @ %
respective sources. Each document is then parsed [E s e R :

[ 36(0) _80(0)

into sentences and analyzed for protein-protein
associations. Agilent Literature Search Software
uses a set of "context" files (lexicons) for defining
protein names (and aliases) and association terms
(verbs) of interest. Associations extracted from
these documents are collected into a Cytoscape
network. The sentences and source hyperlinks for A
each association are further stored as attributes of
the corresponding Cytoscape edges.
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Agilent Literature Search Plugin Features:

» Meta-search engine combining Information Retrieval & Knowledge Extraction
+ PubMed, OMIM, USPTO

» Load/Save/Reanalyze search results

» Paged Search results view

» User context-based aliasing

» File-based lexicon management

« Symbol identification, interaction extraction

» Cytoscape session load/save compatible

» Putative network generation from literature

» Literature-based evidence gathering for Cytoscape Edges

« Extend a Cytoscape network with associations extracted from the literature



Loading Networks

There are 4 different ways of creating networks in
Cytoscape:

1. Importing networks from Web Service

2. Importing pre-existing, unformatted text or Excel

files.

Importing pre-existing, formatted network files..

4. Creating an empty network and manually adding — m—
nodes and edges. S

w

Loading Networks from a Web Service T m—

In this section we will look at how to import networks
using Web services.

8o Import Network from Database.

First, select the File=> Import-> Network from Web
Seerce menu ltem. Import Network From Database

Data Source |_Pathway Commons Web Service Client 4] (CAbout )

Step 1: Search. Select a Data Source and an organism. Type in

TRAFL [ Human 1) (Csearch )

a search term or set of search terms separated by commas. In cms 153 . er .

About

this example we use the Pathway Commons Web Service Client ety oo coleces o b ponney b ch o

pathway information collected from public pathway databases, which
You can browse or search.

as our Data Source, Human for Species' and enter TRAF1 as our Pathuiays include biochemica reations, complex assembly, ransporc

and catalysis events, and physical interactions involving proteins, DNA,

search term. , small molecules and complexes.

[Yale) Import Network from Database

Step 2: Select. Select the protein or small molecule of interest.
Full details regarding each molecule are shown in the bottom
left panell Data Source [_Pathway Commons Web Service Client ) (CAbout )

(Search  Options

Step 1: Search
TRAFL Human 4] (Csearch
Examples: TP53, BRCAL, or SRY.

Step 3: Select Network: Double-click on TNF receptor signaling s

|| R |- (" Pathways

TRAF2_HUMAN U eem——
athway a

athwa ;::T:Dimmb‘ TNF receptor sign... NCI / Nature Path

. - 4 HIV-1 Nef: Negati.. NCI / Nawre Path

RIPKZ_HUMAN
Details
TRAF1_HUMAN
Homo sapiens
Synonyms:

> Double-click pathway to retrieve.
- Epstein-Barr




As the network is loading, you will see a progress
dialog that indicates the percentage of the network
that has been loaded.

When the network has successfully loaded, you
will see it displayed in the top center panel
(Network View). There will also be a ‘birds eye’
overview in bottom-left panel that shows the
entire network and a Visual Legend in the Results
Panel at right, which gives details about the visual
mappings for the network view.

Notes

®& Cytoscape File Edit View Select Layout Plu

bE QaQe BRE

[&1 HV-1 Nef: Negati... NCI / Nature Path

> Double-click pathway to retrleve.

¥ Edge Attribute Browser _ Network Attribute Browser
Welcome to Cytoscape 2.7.0 Right-click + drag to ZOOM Middle-click + drag to PAN

®& Cytoscape File Edit View Select Layout Plugins Help
()

Cytoscape Desktop (New Session)
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Results Panel

‘= Node Details. =

Visual s ([
Legend Fduss

Edge Type

IN_SAME_COMPONENT

Node Attribute Browser | _Edge Attribute Browser  Network Atribute Browser

Welcome o Cytoscape 2.7.0 Right-click + drag to ZOOM Middle-click + drag to PAN




Now let’s extend our network by merging in the known protein-
protein interactions for TRAF1. Follow the same procedure as P ———
above, but this time select the Interaction ‘, (o)
Networks tab under Step 3: Select Network, then
push the button labeled Retrieve Interactions and
select Create New Network in the dialog box that « Use import network from table:
appears. — Excel file

— Comma or tab delimited text

This will bring up the protein-protein interaction TEIRESETTEEE
network for TRAF-1. Of course, this results in ke

pretty much a star network (all nodes connect to
TRAF1), so it might be interesting to expand our
network by adding another of the TNF Receptor

Associated Factors, TRAF2.

,,,,,,,,

We follow the same procedure as above, selecting TRAF2. Now,
though, when the dialog showing all of the interactions being
imported comes up, we select the Merge with
TRAF1_HUMAN_Network (the name of the network we created
before) option.

[ 3
fan esktoj lew Session)
bH Q@ @ B B

Control Panel % Faoe T Restits Panel i

= Node Details

Visual  Filter H
es

The combined TRAF1/TRAF2 protein-protein - s

Rotate |-Scale| Align and Distribute |

interaction network will be displayed.

Us 14 12 1 2 4 8

("Reset scale bar )

Node Attribute Browser | Edge Attribute Browser _ Network Attribute Browser
Welcome to Cytoscape 2.7.0 Right-click + drag to ZOOM Middle-click + drag to PAN



Load a Network from a Table

In this section we will explore how to create Cytoscape network by importing a pre-existing text
or Excel file. The figure at right shows one such example network, consisting of four nodes and
four edges.

Let’s begin creating the network by selecting the File> Import-> Network from Table (Text/MS
Excel)... menu item.

Notes

actiyates

& Cytoscape JITY Edit View Select Layout Plugins _Help

8006 4 New > B

o] ~0 T
5E a > - &= [
[ ~os

Network (Multiple File Types)...
Network from Table (Text/MS Excel)...
Network from Web Services...

Node Attributes...
Attribute from Table (Text/MS Excel...

Edge Attributes...

Ontology and Annotation...
Attribute/Expression Matrix... ~E
Vizmap Property Fi

Quit ~Q

Import attributes from Biomart...
Import Attributes from NCBI Entrez Gene...

Data Panel a3

H0Ols ==

( Browser | Edge Attribute Browser _Network Attribute Browser |

Middle-click + drag to PAN

€
Welcome to Cytoscape 2.8.0 Right-click + drag to ZOOM




An interactive graphical user interface allows you to
specify parsing options for specified files. The screen
provides a preview that shows how the file will be
parsed given the current configuration. As the
configuration changes, the preview updates
automatically. In addition to specifying how the file
will be parsed, you also choose the columns that
represent the Source nodes, the Target nodes, and an
optional edge interaction type.

Under the Advanced section, check the checkbox
labeled Show Text File Import Options.

You will see a set of checkboxes appear. These allow
you to choose the:

* Delimiter. The delimiter character that separates
columns (fields) in the import file. This can be a
tab, comma, semicolon, space, or any arbitrary
delimiter character that you define.

* Preview options. This is a control for how many
preview lines you see in the bottom Preview pane
of the dialog. You can set this to preview all
entries in the file or a subset of the entries
(typically the first 100 entries).

* Attribute Names. You can choose whether to use
the first line of the file to supply attribute names,
one name per delimited column in the file.

e Startimportrow. You can set the import line
number so that you can skip over any initial
header or comment lines in the file.

* CommentLine. You can indicate a character, e.g.
‘#’, to distinguish comment lines in the import
files, so that they are not treated as network data.

* Default Interaction: You can set the name of the
Default Interaction type, which is used to name an
edge. The example in our figure uses ‘pp’ (for
protein-protein interaction) as its default
interaction.

Now use the Source Interaction, Interaction Type,

® Cytoscape File Edit View Select Layout Plugins Help

Cytoscape Desktop (New Session)

BH QA0a s 8@ AR

import Network and Edge Attributes from Table

Control Panel

Data Sources.

Input File file. Talks /G xt

Select File(s)

Interaction Definition
Source Interaction Interaction Type

Select Source node ¢

Target Interact
7#) € [Default interaction 1#) € [ Select Target node col

@ Columns in BLUE will be loaded as EDGE ATTRIBUTES.
Advanced
__ Show Text File Import Options
Preview
B Text File

[ Network.txt |

Left Click: Enable/Disable Column, Right Click: Edit Column

X Colu % X x x x
Symbol

22728

& Cytoscape File Edit View Select Layout_Plugins _Help

d Edge Attributes from Table

a0

| L4

|| ® G@ Import Network from Table
P—

) € (Select Target node column.

Select Flets) )

100 [7) entries

(Refresh preview.

& Cytoscape File Edit View Select Layout Plugins Help

Import Network ibutes from Table

a0
o]"®
| Import Network from Table

Interaction Type

) ¢ (Columns #) & (Column

(@ Cotumns i 510 wil be loaded as EDGE ATTRIBUTES.

and Target Interaction combo boxes in the Interaction Definition to chose the columns for edge
source, edge interaction type, and edge target, respectively. The figure above shows Column 1 is
being used for Source Interaction, Column 5 for Interaction Type, and Column 2 for Target

Interaction.



& Cyloscape File Edit_View Select Layout _Plugins _Help

You can also use additional columns of data as edge [ —
attribute values by checking their column header. In this
case the column labeled Weight has been checked and
marked blue to indicate that its values will be loaded as
edge attributes.

(CselectFite )

Interaction Type Target Interaction
) € [ Columns ) & (col 2 2}

(@) Cotumas in 510 wil belosded s EDGE ATTRIBUTES.

When you are satisfied with the settings, press the import
button and the network will be imported. You will see a
figure that looks like the figure on right.

The values of edge attributes can be used as arguments to

graph layout and other computational operations. In the

bottom example on right, the attribute for Weight is used ————————

in the calculation of coordinate positions using > Qe @ B BEl B
Cytoscape’s. Force-Directed Layout. )

S
&

Data Panel

et BOis

Edge Label Color

Notes

Edge Label Opacity
Edge Label Width
Edge Line Style
Edge Line Width

[-Node Attribute Browser_Edge Attribute Browser _ Network Attribute Browser |
Welcome to Cytoscape 2.8.0 Right-click + drag to ZOOM Middle-click + drag to PAN
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Load Attributes

In this section we will explore how to create
Cytoscape attributes and values by importing a pre-
existing text or Excel file.

Let’s begin creating the network by selecting the
File -> Import -> Attribute from Table (Text/MS
Excel)... menu item.

Select under Advanced section the Show Mapping
Options and Show Text File Import Options
checkboxes, which set up dialogs for controlling

Text Import options (as in example with networks)
and Show Mapping Options, which give you a
number of options for associating network nodes
with elements in the dataset. This enables us to
encode the data as visual properties, such as color,
shape, and overlay the network nodes with the values
of those properties.

Notes

Loading Attributes

* Loading attributes

— Use import attribute tfrom table

¢ The Data Panel

-,
&

& Crtoscape [T Edit_View Select_Layout_Plugins _telp
fNO i

New » Hoscape

T T —

e -

0" ®

i L Import Attribute from Table
o sources
Autbutes

cccccc




Now we are ready to map the nodes of the network
to the data you have.

lo]"®
@ Import Attribute from Table

If you right-click on a column header, a dialog box
will be displayed. You can fill in a name for the
attribute. You can also set the type of the elements
in the data column, to one of: the primitive data
types that Cytoscape supports are: String, Integer, :
Floating Point, and Boolean. You can also set the e U ——

vvvvv o Attribute Name and Type
[E2) TextFite Left Click: Enable/Disable Colum

datatype of the column to be a list of primitive i
elements of one datatype.

@ Node O Edge O Network

nnnnnn

Now you need to map unique identifiers between
the entries in the data and the nodes in the network.
The key point of this is to identify which nodes in
the network are equivalent to which entries in the
table. This enables mapping of data values into visual properties like Color and Shape. This kind
of mapping is typically done by comparing the unique Identifier attribute value for each node with
the unique Identifier value for each data value. As a default, Cytoscape looks for an attribute value
of ‘ID’ in the network and a user-supplied Primary Key in the dataset. The user can change these
values via combo boxes in the Mapping section:

* Primary Key: combo box that allows you to choose the column that is to be used as key for
mapping values in the dataset. You can also set an arbitrary number of columns as aliases
via checkbox, in which case those supplied alias will be used in addition to the Primary Key
in the attempt to map identifiers.

* Key Attribute for Network: combo box that allow you to set the node attribute that is to
be used as used as key to map to.

If there is a match between the value of a Primary Key in the dataset and and the value the Key
Attribute For Network field in the network, then all attribute-value pairs associated with the
element in the dataset are assigned as well to the matching node in the network.

You can control some of the options for ID Mapping by s -
using the controls in the Advanced section. Select under (B ——
Advanced section the Show Mapping Options. Show ;
Mapping Options, which give you a number of options for
associating network nodes with elements in the dataset.
This enables us to encode the data as visual properties, such
as color, shape, and overlay the network nodes with the
values of those properties.




There is a checkbox entitled “Import everything (Key is
always ID)”. If this is checked, Cytoscape will create an
attribute value pair for every entry in the dataset,
regardless of whether it maps to an equivalent attribute
name. Now check Show Mapping Options checkbox
under Advanced section. You can also check the Case
Sensitive checkbox if the string comparison is to be done
in a case insensitive way (e.g. if stat1 gene is the same as
STAT2 gene).

Once attributes are imported, we can inspect them in the

Data Panel. Right clicking on the leftmost icon in the toolbar

under DataPanel title bar will bring up a menu of checkboxes. If you check a checkbox for any
attribute in that attribute and its values will be displayed as a column in of values on the
DataPanel.

If you a select a node in the network, its attribute values CLICEE N N E—" — '
will be displayed in the control panel.  ——— @
Notes \///u\

uuuuuu
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Tips and Tricks

Cytoscape is a large, complex, and dynamic
software system. A little knowledge of the
internals organization and operational model of
the software will enable more efficient use of the
software. Here are some useful Tips & Tricks to
help you get the most out of your Cytoscape usage.

The ’"Root Graph”

There is one central root graph that contains all
nodes and edges. Thus all networks are ‘views’ on
that single graph, and nodes and edges are unique
across all networks. Modifying a node in one
network will modify that node in all other

networks that it appears in. There is no way to
have two or more copies of a node with the same ID.
The only workaround would be to make a copy of a
Cytoscape session.

Network Views

For efficiency in dealing with large networks, a view
is not automatically generated when the size of the
network is over a user-definable threshold. You
can manually generate a Network View by right-
clicking on its entry in the Network Navigator Panel
(upper left o Cytoscape desktop)., then selecting
‘Create View’. You can also use that right-menu
item to ‘Destroy View’, ‘Destroy Network”, and edit
the Network’s title.

Tips & Tricks

* “Root graph”
— “There is one graph to rule them all....”
— The networks in Cytoscape are all “views” on a
single graph.
— Changing the attribute for a node in one network will
also change that attribute for a node with the same
ID in all other loaded networks

“

— There is no way to
D

— Make a copy of the session

copy” a node and keep the same

Vienna, Austria

Tips & Tricks ::;

» Network views
— When you open a large network, you will not get a
view by default
— To improve interactive performance, Cytoscape has
the concept of “Levels of Detail”

* Some visual attributes will only be apparent when you
zoom in

* The level of detail for various attributes can be changed in
the preferences
» To see what things will look like at full detail:

— View=>Show Graphics Details

Vienna, Austria

To improve interactive performance, Cytoscape has the concept of Levels of Detail? This is
basically a mechanism for semantic zooming, where different levels of detail com into play at
different levels of detail (think of the Google Maps interface where a City is represented by a
yellow patch at high level then shows more of the structure of streets and avenues as you zoom in.

Some Cytoscape attributes will only be apparent when you zoom in. The level of detail for various
attributes can be changed in the preferences. To see what things look like in full detail, select the

View—> Show Graphics Details menu item..

Sessions

Sessions save pretty much everything:
Networks, Properties. Visual styles, Screen
sizes, and many other types of information.
When working on a complex study of workflow,

Tips & Tricks

Sessions
— Sessions save pretty much everything:
* Networks
* Properties
* Visual styles
* Screen sizes
— Saving a session on a large screen may require some
resizing when opened on your laptop

Vienna, Auvstria 4



it is often prudent to save one’s intermediate results as a session, so that the current state of an
activity is persisted and can be resumed without having to repeat earlier low-level operations.
Not all state is the same, however. For example, saving a session on a large screen may require
some resizing when re-opened.

Logging .
Logging can help you get to the bottom of : Tips & Tricks 8
operations that have gone awry. . By default,
Cytoscape writes its logs to the Error Dialog:

» Logging

— By default, Cytoscape writes it's logs to the Error

via the Help - Error Dialog menu item. Dirloiz: FielPBimr Dl

— Can change a preference to write it to the console
You can change a preference to write the log to B> Prefreasons 3 Prope i
the console via: + Set logger.console to true

» Don't forget to save your preferences

* Restart Cytoscape

Edit-> Preferences-> Properties... menu item. 4

. — (can also turn on debugging: cytoscape.debug, but I
To do this, set the Set the logger.console dont recampnend i
property to true. Don’t forget to save your
preferences. Then you can restart Cytoscape.

Vienna, Austria g

Memory Tips & Tricks S
Cytoscape uses a lot of memory and, as a Java

system, doesn’t like to let go of it. When B Memory

working with large networks, an occasional _ Cytoscape uses lots of i

save session and restart will help clear out — Doesn't like to let go of it

memory. Another efficiency measure is to — An occasional restart when working with large

networks is a good thing

destroy large network views when not needed.

— Destroy views when you don’t need them

— Java doesn’t give us a good way to get the memory

One particular challenge is setting virtual P S

memory sizes Correctly upon Startup. ]ava « Cytoscape 2.7 does a much better job at “guessing” good
: : default memory sizes than previous versions

does not provide very good ways to do this,

although Cytoscape from version 2.7 has Viena, Austia

become better at “guessing” good default
memory sizes than previous versions.



Final points on Tips and Tricks
.cytoscape directory

Tips & Tricks

This directory is typically located under j -l diEsiory
— Your defaults and any plugins downloaded from the

your home direCtory' for example ona plugin manager will go here
Windows system it will be under

— Sometimes, if things get really messed up. deleting (or
renaming) this directory can give you a “clean slate”

C:\Documents and Settings\<username> * Plugin manager
— “Outdated” doesn’t necessarily mean “won't work”
Your defaults and any plugins downloaded — Plugin authors don't always update their plugins

. . . . immediately after new releases
from the plugln manager will go1n this — Click on “Show outdated plugins” to see the entire list of

directory. Also, plugins may use this plugins.
directory to store configuration

Vienna, Austria g,

Sometimes,, if things get really messed up,
deleting (or renaming) this directory can give you a “clean slate”

Plugin manager

When a plugin is labeled as “Outdated”, it doesn’t necessarily mean “won’t work”
Plugin authors don’t always update their plugins immediately after new releases

Click on “Show outdated plugins” to see the entire list of plugins.

Notes




Demo/Sample use cases

Use case 1: Expression data analysis

This use case highlights the visual display of
expression data, integrated clustering features,
and basic Gene Ontology overrepresentation
analysis. Note: we are starting with an expression
dataset that has already been normalized,
statistically analyzed, formatted, imported and
associated with an interaction network.

The dataset

Differential gene expression of GAL deletion
mutants grown in the presence and absence of
galactose[122]. Fold values were mapped onto a
protein-protein interaction network focusing on
galactose utilization in yeast, Saccharomyces
cerevisiae. Additional annotations (e.g., gene and

protein identifiers, GO terms, pathway associations,

etc) have also been added as node attributes. This
dataset is included with the download of
Cytoscape in the sampleData folder and is called
galFiltered.cys.

Locate and open the galFiltered.cys session file.
Check out the VizMapper settings for node color.
By default, the nodes are colored by the fold value
gal4RGexp. Explore the visualization of other fold
values in the dataset: gal1RGexp and gal80Rexp.

Notes

REVI Expression data analysis &

* Load galFiltered.cys

» Explore the expression fold changes: gallRGexp,
gal4RGexp, and gal80Rexp. The network is
colored by gal4RGexp values.

* To explore the expression profile for these three
deletions, we can use clusterMaker to do a
hierarchical cluster

— Plugins>Cluster>Hierarchical

— Chose the attributes we’re interested in (node.gallRGexp,
node.gal4RGexp, node.gal80Rexp)

— Chose the type of clustering (pairwise average-linkage,
Euclidean distance)

— Click Create Clusters

= (0/&8 s EFIE |




Cluster analysis

8,00 Hierarchical cluster Settings

To explore the expression profiles for the three ierarchical cluster Settings
deletions, we can perform clustering within S =
istance Metric uclidean distance
Cytoscape using the clusterMaker plugin. Saurce for aray data
node.gallRGexp
node.gal1RGsig r
In the Plugins menu, select Cluster > Hierarchical. Array sources hode gaHRGH 7
fode gals0Rexp |-
. Clustering Parameters
°® Choose the type Of CIUSterlng' Only‘use sge[ected :\odes/edges for cluster O
3 3 3 Cluster attributes as well as nodes a
O palrWISe average-llnkage Ignore nodes/edges with no data 4

Advanced Parameters

* Choose the attributes of array data:
O nOde'gal 1 RGeXp Create groups from clusters

O nOde'gal4RGexp Create Clusters ) Visualize Clusters (_ Save Settings ) Cancel ) ( Done
o node.gal80Rexp

| » | Show Advanced Parameters

(e e

ClusterMaker TreeView : galFi

® (Click: Create Clusters :
*  When done, click: Visualize Clusters —

This will bring up the TreeView of your cluster results.
Each row is a gene and the three columns correspond to
the three data attributes. A dendrogram to the left
expresses the relationship between clusters, and the
region to the right shows a close-up and labeled view of

selected rows. G Commn) (o) (morommmst) (o

If the colors are too dark, or if you prefer other colors
altogether, you can open Settings... and adjust a number
of preferences.

800 ClusterMaker TreeView : galFiltered.sif

[Vero1ec
IVero19C
IVERoZ0W

Now, select the top most branch of the dendrogram, as
shown on the right. Notice that selections in TreeView
correspond to selections in the network!

Notes




GO term overrepresentation analysis . -
Now we can see if any of the selected genes from Expression data analysis &
that first cluster show any GO term

overrepresentation. In other words, are there

» Now we can see if these genes show any GO

overrepresentation
particular GO terms that are enriched (or » Start BinGO
overrepresented) in this subset of genes? We can — Plugins>Start BINGO

— Give the clusters a name (e.g. clusterl)

Click on Start BINGO to process the data

. . The results include a table, and a network of GO
* Plugins > Start BiINGO associations

* Give the cluster a name In this case the top term is “galactose catabolic
e  Click: Start BINGO E;)lgzss via UDP-galactose”, which makes good

do this using the BiNGO plugin.

* Note: there are many parameters you can
play with. The defaults are usually sufficient
for a first pass as major trends.

The results are displayed as a table and as a network of GO associations. The GO terms are
connected based on their inherent hierarchical relationship and they are colored based on the
significance of their overrepresentation in your cluster.

ann IFiltered.cys)
PH QANR @ B BB B

Control Parel “Feno cluster.

800" _ - BINGO output
(etusten]

Notes






Use case 2: Protein complexes in protein-protein
interaction networks

This use case highlights the combined use of MCL
clustering of protein-protein interaction (PPI)
networks and hierarchical clustering of epistatic
mini-array profile (EMAP) data to explore
potential biological protein complexes.

The dataset

We will be working with a Cytoscape session file
containing three networks: one is a yeast PPI[27]
and the other two are yeast EMAP datasets [7,
123]. Note: we will not bother viewing the EMAP
datasets as networks, but rather treat them as sets
of nodes and attributes. You can perform clustering
on sets of nodes without creating a network view!
The key to making this analysis work is having the
same node identifiers in both the PPl and EMAPs.

The dataset is provided with this tutorial and is
called collinsPlus.cys:

* combined_scores_good.txt (PPI)
* DNA and Tran 07-21-06b.csv (EMAP)
* RNAPuberNovZ2+Meg6c.csv (EMAP)

Notes

Protein Complexes

* Load collinsPlus.cys

— Three networks, but only one view
 combined_scores_good.txt: Combined MS/TAP Yeast PPI network from

* DNA and Tran 07-21-06b.csv: Yeast EMAP
* RNAPuberNov2+Megé6c.csv: Yeast EMAP

cape Desktop (Session Name: collinsPlus.cys)

Cytose
BEH QAR Q @ ©




MCL clusters in the PPI network

First, we will identify the MCL clusters in the protein-
protein interaction network. Under the Plugins menu,
choose Cluster and then MCL cluster:

* Density Parameter: 1.8

* Weak Edge Weight Pruning Threshold: 1.0E-10
* Maximum residual value: 0.00000010

* Array source: PE Score

* (lick: Create Clusters

e When done, click: Visualize Clusters

8.0.0 MCL cluster Settings
MCL cluster Settings
MCL Tuning
Density Parameter 25
Weak EdgeWeight Pruning Threshold 1.0E-10
Number of iterations 8
The maximum residual value 0.00000010
Source for array data
Array sources [(PEscore  [%])
Cluster only selected nodes (=]
Edge weight conversion
Edge weight cutoff
185 6.72 116 16.47 2135 2620 2%
Set Edge Cutoff Using Histogram Edge Histogram )
Array data adjustments
Assume edges are undirected )
Adjust loops before clustering ™
Advanced Settings
\;J Show Advanced Settings
("Create Clusters ) ( Visualize Clusters ) (_Save Settings ) (_Cancel ) (_Done )

Cytoscape Desktop (Session Name: collinsPlus.cys)

There are your MCL clusters.

BE QaaQ| ﬁ e e g a—

Control Panel
. [ % Network | VizMapper™
Beautiful, aren’t they! These are our — .
(1 combined_scores_good.txt 2

first approximation of potential
protein complexes based solely on
tightly interacting protein clusters.

Next, we consider the clusters
generated from EMAP data as an
orthogonal form of evidence based

[l combined_scores_good. txt--cliF 3
| 7.
- 5

.. . - P

on genetic interactions. Combining - ’
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The EMAP clusters identify potential complexes based on genetic (functional) interactions. Now,
we can explore the correspondence of evidence from these two methods. For example, search for
GIMS5 and select the entire cluster. Notice how the corresponding interactions are dynamically
highlighted in the TreeView. Notice how both EMAP and PPI data do not provide strong support
for the inclusion of BUD27 in this potential complex.
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Hands-on tutorial: Introduction to Cytoscape

This tutorial will cover:

Navigating Cytoscape
Visualizing Data on Networks
Network and Pathway Resources
Plugin Manager

Plugin Demos

G W

By the end of the tutorial, you should be able to use Cytoscape to import networks and attributes
and visualize those attributes on the network.

Notes




Hands-on tutorial: Working with data

This tutorial will introduce you to:

1. Searching Internet interaction databases with query terms.
2. Mapping Identifiers of different types to networks.
3. Finding your query terms in the downloaded network.

The second half of the tutorial will introduce you to some advanced basics in Cytoscape:

1. Apply filters to filter out low-confidence edges.
2. Perform basic edits using the Cytoscape graph editor.

Notes




Hands-on tutorial: Analysis of microarray data

This tutorial will introduce you to:

1. Combining data from two different sources: experimental data in the form of microarrray
expression data and network data in the form of interaction data.

2. Visualizing networks using expression data.

3. Filtering networks based on expression data.

NOTE: The expression data used in this example has been pre-processed to work with the
interaction network used.

Notes
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